GiD v13 news

GiD Developer Team:
Miguel Pasenau, Enrique Escolano, Jorge Suit Pérez, Abel Coll, Adrià Melendo, Anna Monros and Javier Gárate

8th GiD Convention on advances and applications of GiD

June 1st, 2016
Main general news
Main news in preprocessing
Main news in customization
Main news in postprocessing
GiD in the Social Networks
Future lines
Round table
GiD 13 Presentation - Outline

- Main general news
- Main news in preprocessing
- Main news in customization
- Main news in postprocessing
- GiD in the Social Networks
- Future lines
- Round table
Mac OS X version

Released GiD 13 official version for Mac OS X
Apple OS X version: classic + embedded menu
Apple OS X version: themes and menus

Combining El Capitan’s dark theme and GiD black theme
Apple OS X version: black + native menu
Html help and internal viewer

GiD help with our html viewer:
• Faster loading.
• More user friendly.
• Html format allow use other web browsers.
• Facilitate developers to write documentation using standard tools.
• Same look as the rest of the GiD windows.
• Tkhtml Tcl package allow embed html widgets.
Antialiasing

New OpenGL option

![Screenshot of GiD preference window showing antialiasing option](image)
Antialiasing
Antialiasing
Antialiasing
Antialiasing
GiD now working with IGA (Preprocess)

- GiD’s powerful CAD system working with trimmed NURBS surfaces
- Exchange NURBS geometries with various formats (IGES, STEP, ACIS, among others)
- Graphical assignment of materials, boundary conditions, loads, B-Rep properties, coupling information, etc. directly to the geometry

* Computations by Chair of Structural Analysis, Technische Universität München M. Breitenberger, A. Apostolatos, B. Philipp, R. Wüchner, K.-U. Bletzinger, Analysis in computer aided design: Nonlinear isogeometric B-Rep analysis of shell structures, CMAME 284 (2015) 401–457
From GiD to your IGA & IBRA solver:

- All necessary data for analysis like parametric and geometric information or material properties and conditions. Can be accessed using simple functions:
  
  **GiD_Info parametric:** Returns geometric information (coordinates, derivates, etc.) about parametric lines or surfaces, able to map points and lines over U,V.
  **GiD_Geometry list / get:** Get data or list the identifiers of geometric entities.
  **GiD_Info list_entities:** Access to what and where is applied, full control of know conditions and materials that user had graphically applied.

  
  `write_calc_data puts "--Input file: [GiD_Info gendata] --"`

- All information from the model accessible via Tcl.
- All data can be written in the format that your solver needs.
From your IGA solver to GiD

- As easy as writing a text file, giving the scalar, vector or matrix result on control points of the NURBS, giving access to the complete graphical postprocessing system of GiD
- GiD provides a post library for writing results in ASCII and binary format.
- (Use the .geo format to define NURBS in postprocess)

```plaintext
Result "NurbsSurfaceScalar" "Analysis_example_IGA" 1 Scalar OnNurbsSurface
Values
1 | Surface identifier
0.125126 | Scalar result on control point (u=0, v=0)
0.563585 | Scalar result on control point (u=0, v=1)
...
0.479873 | Scalar result on control point (u=m, v=n)
End Values
```
GiD now working with IGA (Postprocess)

- GiD generates automatically a visualization mesh for visualizing the results: contour fill, vector plots, surface extrusions, model deformations, graphs and animations, etc.
- Visualization mesh considers geometry details, curvatures, and results gradients.

* Computations by Chair of Structural Analysis, Technische Universität München M. Breitenberger, A. Apostolatos, B. Philipp, R. Wüchner, K.-U. Bletzinger, Analysis in computer aided design: Nonlinear isogeometric B-Rep analysis of shell structures, CMAME 284 (2015) 401–457
GiD 13 Presentation - Outline

- Main general news
- **Main news in preprocessing**
- Main news in customization
- Main news in postprocessing
- GiD in the Social Networks
- Future lines
- Round table
Increased interoperability with CAD exporting in STEP format (AP214 Automotive Application Protocol)
Some programs don’t support IGES B-rep like topology.
And enhanced the STEP import, supporting more entities.

Pyramid of GiD tutorials rendered in Rhinoceros 5
Import XYZ points/nodes

Common case of simple list of xyz coordinates
Option to triangulate/tetrahedrize connecting nodes.

Octant of sphere reconstructed with triangles
(2D Delaunay in z projection)
New tool to convert a mesh of triangles or quadrilaterals into geometrical surfaces

3D studio mesh imported and converted to surfaces (and coplanar parts joined)

Allow use all geometrical edition tools and re-mesh
List entities: new 'Lines uv' button
'Granular' sphere/circle mesh generator

- Granular: sphere 3D or circle 2D unstructured generation.
- Statistical radius distribution

- Plug-in of an external mesher*.  
  *Developed by aula Cuba researchers
New MinElem mesher

Surface mesher with unstructured triangles
Objective: approximate the shape with a small amount of triangles, without considering its quality (angles, sizes, etc.)

Applications:
- Conformal rendering for visualization
- Input for other meshers
- Input for some kind of analysis

Example: Rfast vs MinElem
About 20% less triangles
Mesher for embedded methods

Non-conformal volume mesh of tetrahedrons
Tetrahedral faces doesn’t match input surfaces

Provides tetrahedral octree-refined mesh near the surfaces
Provides distance field to cutting boundary

Pros:
- Few volume elements
- Mesh easy to be generated
- Doesn’t require a conformal input

Cons:
- Non-fitting surfaces
- More difficult simulation
- Weak result approximation
Other enhancements

- Parallel surface meshing (Multithreading)
- Layers: allow deletion also if it has entities, parts in back, conditions or child layers.
- Entities of frozen layers represented in grayed color.
- Internet retrieve window: allows to get plugins and other documents, added filters to hide incompatible or installed modules.
GiD 13 Presentation - Outline

- Main general news
- Main news in preprocessing
- **Main news in customization**
- Main news in postprocessing
- GiD in the Social Networks
- Future lines
- Round table
New problemtype system integrated

CustomLib: Tcl/Tk package to develop ProblemTypes

- XML description of the data
- Tree to show and edit the information
- Coupled to groups to attach data
- Calculation file written with Tcl
- Handle of units
- Tool to import/export materials
- Freely usable without extra licences

Cmas2d_customlib example
Voro++ plug-in

Voronoi polygons generator (Wrapper to Voro++ open source program)

- 2D, 2.5D or 3D dimensions
- Force periodicity in x, y or z
- Read/Save random centers
- Creation of contacts
- Creation of extruded matrix
- Optional random pores
- Classificate parts in groups
- Semi-structured mesh data
- Uses: synthetic polycristals, granular soils, etc.

Voro++ window

Flow in a porous media (extruded matrix)
Customization example: Hypermembrane project

Construction system for freeform structures.

Simple 2D beam pattern (3 layers of ribbons).
3D shape set by length of actuators
A net fit 3D surfaces
The problem type creates parametrically the geometry and do the structural simulation.
GiD 13 Presentation - Outline

- Main general news
- Main news in preprocessing
- Main news in customization
- **Main news in postprocessing**
- GiD in the Social Networks
- Future lines
- Round table
Reorganization of the top menu

• Some options have changed its location and/or name

• Motivations:
  • Take advantage of Preferences Window
  • More intuitive classification
Reorganization of the top menu

- **GiD 12**
- **GiD 13**
  - Deleted: “Do cuts” and “Options”
  - Added: “Geometry”
Reorganization of the top menu

• “Options” top menu mostly in “Postprocess” branch of the preferences window
Reorganization of the top menu

- New “Geometry” menu → Actions that modify the mesh
  - Cuts and divide options, mesh operations
Reorganization of the top menu


Postprocess top menu has changed from version 12.

Some options have changed its location and/or name.

This annex is a reference to find the old options in the new GiD versions.

Utilities menu

- Collapse nodes: Geometry->Collapse nodes (see Collapse nodes)
- Join: Geometry->join (see Join)

Do cuts menu

- Cut plane: Geometry->Cut plane (see Cut plane)
- Divide by selection: This action can be done through the Select & Display Style window (Window->View style) (see View style)
- Divide volume sets: Geometry->Divide->Volume sets (see Divide)
- Divide surface sets: Geometry->Divide->Surface sets (see Divide)
- Divide lines: Geometry->Divide->Lines (see Divide)
- 2d polygonal cut: Geometry->Cut 2D polygonal (see Cut 2D polygonal)
- Cut sphere: Geometry->Cut sphere (see Cut sphere)
- Convert cut to surface sets: Geometry->Convert to sets->Cuts (see Convert to sets)

Options menu

- Legends: Utilities->Preferences->Postprocess->Legends and comments (see Legends and comments) and comments and Utilities->Tools->Change legend title (see Change legend title (only Postprocessing))
- Reference axes: View->Reference axes (see Reference axes (only Postprocessing))

GiD v13

8th GiD Convention on advances and applications of GiD
Macro for ‘result fill’ visualization: material fill
Postprocess changes

‘Reload’ button in postprocess to refresh results while calculating, actualizes view to last step
Preserve spaces and special characters in meshes, analyses and result names
Elemental gauss point for spheres
Graphs options: saved with the project, font selection
Stress vector colours can be changed
Better integration of transparent and opaque preprocess layers into postprocess rendering
Dynamic iso-surface creation with optional contour fill
GiD 13 Presentation - Outline

- Main general news
- Main news in preprocessing
- Main news in customization
- Main news in postprocessing
- GiD in the Social Networks
- Future lines
- Round table
GiD goes social!
GiD goes social!

- Get the latests news
- Spread the word
- Are you a problem type developer? Are you using GiD? Ask us for dissemination
- Twitter:
  - #GiDinside, #GiDapplicationsfields, #GiDtips...
- LinkedIn:
  - Cimne’s showcase page
- Youtube:
  - Oldest GiD social network
  - Examples runned in GiD
It looks that the #sun will shine during the #GiDconvention! bit.ly/GiDbarcelona See you tomorrow in Barcelona!
Follow us in LinkedIn

- Search for “GiD pre post”

https://www.linkedin.com/company/gid-the-personal-pre-and-post-processor
Subscribe to our Youtube channel

- Search for "GiD home"
New web

Big improvement on webpage, current and future effort to offer better and relevant content

User friendly in any platform from desktop to mobile
Forum

Clear and neat forum interface, to do not distract from the important, solve users problems

User friendly in any platform from desktop to mobile
GiD 13 Presentation - Outline

- Main general news
- Main news in preprocessing
- Main news in customization
- Main news in postprocessing
- GiD in the Social Networks
- **Future lines**
- Round table
Future lines

Explore possibilities to develop a ‘lighter’ version of GiD/viewer (browser)
Separate some features into libraries (boundary layer mesher, streamlines calculation, isosurfaces, etc...)
Selection using polygonal shapes
More features to work with large models, multi-resolution
Specifics:
- Cuts with “automatic volume-off and rotation”
- Support internally hdf5/vtk/xdmf
- ?menus and animation ‘rework’?
- ?volume rendering?
Future lines

Integrate finite difference cartesian mesher
3D Image to mesh conversion
Web: facilitate payment mechanisms
Documentation: videotutorials
GiD 13 Presentation - Outline

- Main general news
- Main news in preprocessing
- Main news in customization
- Main news in postprocessing
- GiD in the Social Networks
- Future lines
- Round table
Round table

User comments
Wish list
Thanks for your attention